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Welcome to SiteMaker

SiteMaker is a unique website builder that allows you to edit your website in the same way that you
browse it. Because of your unique SiteMaker username, when you are logged in to your site we
recognise that you are the site owner and display the edit tools to you. Normal visitors will not be
able to edit your site.

When you go to your website for the first time, you will be automatically logged in to edit

it. But if you ever need to login to make changes in the future, you will first need to enter this
mode. To do this, you must go to your Gandi SiteMaker interface on our website
(http://gandi.net/admin/sitemaker) and click on the pen icon ("Edit the contents of this website")
that corresponds to the website that you want to change.
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The SiteMaker Edit Environment

Your website is made up of a number of different pages, which are organised into your site's menu
and form the main navigation for your site. The menu will automatically display all the pages in
your site and provide links to each of them. (Screen 1, A)

When you are successfully logged in to your site you automatically enter 'Edit mode'. In Edit Mode
you can still see all of your pages and content, but we also overlay the edit tools that allow you to


http://gandi.net/admin/sitemaker
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add/remove/update the contents of your site. In Edit Mode you should see:

i) The SiteMaker Toolbar - At the top of the page this contains links to the core editing functions of
SiteMaker, e.g. adding/removing pages, copy/paste, design settings, etc. You also have a choice
between basic (default) and advanced toolbars. (Screen 1, B)

ii) The Page Editor - This floating panel displays basic settings for the object that is selected on the
page, e.g. position and size, background colour and more specific details based on the type of
object selected like font size for text boxes or website address for links. (Screen 1, C)

iii) The File Manager — Opened by clicking the 'Files' icon in the SiteMaker Toolbar (Screen 2,
A), this core tool helps upload and organise your images, videos, MP3s or any other file you add

to your site. (Screen 2, B)
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However, if you wish to see your site as your visitors will, then you can click on the ‘View my site’
button in the top right corner. (Screen 2, C) You will be asked to save any changes and once the
page has refreshed you will see how your site appears to visitors. This will allow you to review the

layout, test any or all functionality and check navigation. To return to edit mode just click on the
‘Edit my site’ button.

If at any point while editing your site you require help, it can be found through the 'Help' icon on the
SiteMaker Toolbar. There you can browse the most common Frequently Asked Questions (FAQs)
or submit a query to the SiteMaker support team.
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Editing Your Page

Now that you are familiar with the SiteMaker Toolbar you should be ready to start editing your
pages. This section covers moving and resizing objects, as well as adding material and text to your
pages.

Selecting Objects on Your Page

Most objects on your page can be edited by clicking on them (except the menu and anything on
the Page Master - see Page Master section below). Generally one click will select the object to
move, scale or rotate it and a double-click will allow you to edit the contents of that object (e.g. edit
the text in a text box).

Moving/resizing Objects

Click on an object once and you will see a single line border appear around the object with resize
handles in the corners. (Screen 3, A) In this state you can click (within the object border) and
drag your object e.g. an image, a text box, a widget (forum, form, audio player etc), to move it
around your page. If you click and drag on one of the resize handles you can also change the size
or shape of the selected object.
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Rotating Objects

Many objects can also be rotated: images, buttons and graphic text/title boxes. Click once on the
object and then use the rotate button on the Editor to enable rotation (Screen 3, B). If you cannot
see this button then rotation isn’t possible on the object. Grab the rotate handles and just drag the
item around to the preferred angle (Screen 3, C), or use the input field on the Editor to enter a
specific value e.g. 90 or 270 to turn the object on to its right or left side or 180 to flip it upside down
(Screen 3, D).

Editing Objects

Double-clicking an object allows you to edit its content, for example the content of a text box. If you
clicked your object to move or resize it then clicking it again will take you into object edit mode.
When you are editing an object a grey shadow/border will appear around the object (Screen 4,

A) and a title box will appear in the top left corner with the object name (Screen 4, B).
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Using the Editor

The Editor will allow you to change the settings of an object although the settings will vary
depending on which type of object or widget is selected. For example:

*A text box allows you to change the text font and style through the ‘Font’ tab (Screen 4, C)
*The form allows adding and editing of fields, their order and adding validation using the ‘Field’ tab
*Changing the transparency of an image (Screen 5, A) and adding an ‘Alt tag’ (alternative text
label for images) to it (Screen 5, B) can both be performed via the ‘Style’ tab

*A crop tool will let you add an image through the ‘Setup’ tab
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The Mini-toolbar

The mini-toolbar can be opened from the Editor using the small button beside the tabs (Screen 6,
A). You can use the mini-toolbar to perform basic functions, which is especially useful when
working at the bottom of longer pages. You will be able to: save the page; upload files; open the
File Manager; copy, paste, duplicate and delete objects; add text boxes, title boxes, and button
links; and move an object below (or behind) others.
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Using Multiple Select

You can select multiple items (objects) on your page so that you can move them as a group
around the page or so that you can copy and paste them as a group. To create a selection, click
your mouse on the page outside the objects’ borders and drag it across your page, which will
create a selection box. Anything within the selection box will be selected after you release the
mouse. (Screen 7, A) Or you can click on objects while holding down the 'Ctrl' or 'Shift' keys to
add to your selection. Once a group of objects are selected you can drag them around your page.
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Copy and Paste

You can copy and paste a single object or an entire selection, onto the same page or to a different
page. To do this first select your object/s and then use the 'Copy' option in the 'Edit' menu of the
SiteMaker Toolbar (Screen 7, B). Either 'Paste’ the selection (also in the 'Edit' menu) onto the

current page or navigate to a different page and paste the object/s there. This can make
duplicating groups of objects or aligning them much quicker and easier.

Editing Text on Your Page

Double-click on an existing text box to start adding or editing the text. There is no limit to the
amount of text you can add, which you can separate onto different lines or paragraphs. If you want
to change the shape of your text box, to create a narrow column for example, just use the square
drag handles to squash or stretch the text box.
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To change other properties of the text box, including font, point size, style and colour, you will need
to use the page 'Editor' (Screen 8, A). The 'Font' tab allows you to make text bold, simply by
selecting (or highlighting) the text and then using the 'B' (Bold) button (Screen 8, B). You can
also add italics or an underline, and you can select a line or paragraph and changes its justification
to left (Screen 8, C), centre, right or proportional.

The text font defaults to 'Standard fonts' in the text box. The drop down on the 'Font' tab will let you
select a new font, e.g. Arial Black, for the entire box. (Screen 9, A)

NB. You cannot select individual words or paragraphs to change font or colour, these are applied
to the entire text box.
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Standard Fonts and Graphic Fonts

There are two types of text fonts available in SiteMaker, standard or system fonts and graphic
fonts. Standard fonts use common fonts that are stored on your computer (system), while graphic
fonts embed whole font sets in your SiteMaker site. Both have a number of benefits and
implications. Standard fonts have more formatting options, e.g. bold, italic, links, etc., and are
much quicker to load as they don't embed the font in your website.

Graphic fonts provide a wider range of choice, do not change between screens or computers and
are optimised for on screen display. They are however, larger files and have more limited
formatting options (e.g. you cannot set links on graphic fonts).

To change the font style (e.g. from standard to graphic) click on the ‘+’ symbol beside the font
dropdown (Screen 10, A) on the Editor. This will open the Font Picker panel. If you were editing
a text box the Standard font dropdown (Screen 10, B) will highlight the current font style. If you

want to use Graphic fonts you can make a selection from the dropdown (Screen 10, C) and save
the selection.

If you want a printable version of what Graphic fonts are available within SiteMaker then just
download the PDF we supply (Screen 10, D).

A common practice is to use graphic fonts for titles and standard fonts for body text which is what
you will find in SiteMaker although you are free to change this anywhere on your site.
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Adding Your Own Images, Audio and Other Files

Adding New Objects to Your Page

You can add any object to your page using the File Manager. Simply click on the 'Files' icon on the
SiteMaker Toolbar and this will open the File Manager (Screen 11, A). The File Manager
contains a collection of files (images, widgets, animations etc.) that we provide which can be found
in the ‘Library’ (Screen 11, B).

We also provide a folder called ‘My Files’ which is where your uploaded files (images, MP3s, docs,
videos, etc.) will be stored and organised. You can browse through the contents of the File
Manager by clicking on the folders and sub-folders and highlighting files. When you want to add

something to the page, select a file and click 'Use this' (Screen 11, C).

You can also access the File Manager and several standard features by using ‘Insert’ on either the
basic or advanced toolbar. Or you can use the Mini-toolbar on the Editor to open the File Manger
as previously described.
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Uploading Your Files
Adding your own files and media is very easy. Simply click on the upload icon on the toolbar or use
the ‘Upload Files’ button (Screen 12, A) on the File Manager which will open the ‘Upload’ panel.

Browsing for files on your computer is just like looking for files with Explorer on Windows or Finder
on a Mac.
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Click the ‘Add files’ button (Screen 12, B) and a browsing panel will now appear (Screen 13, A)
enabling you to explore your computer and then highlight the files you wish to upload. You can use
the 'Shift' or 'Ctrl' key on Windows (‘Shift’ or ‘Cmd’ on a Mac) to highlight multiple files to be

uploaded. Then use the ‘Open’ button to complete the selection process. (Screen 13, B)
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The Upload window will now display the file or files to be uploaded with their respective file sizes.
You can also select the folder into which these files are to be placed (Screen 14, A) (please see
‘Organising Your Files’ below for more details on creating folders). At the bottom of the panel will
also be the total size of all files you wish to upload to your website. At this point you can add more
files (Add files), highlight a file and remove it (trash icon), or go ahead and upload your files using
the ‘Upload’ button (Screen 14, B). You will be shown a progress bar which will indicate the
status of your upload. Once the upload has completed, close the panel or locate your files in the
File Manger.
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File Types

SiteMaker will allow you to upload any type of file you like and add it to any folder you create
(Please see ‘Organising Your Files’ for details). However software is quite specific about the types
of files it can use directly on your site although it does automatically group your uploaded files into
four different types.

The File Manager will then provide ‘Views’ for images, audio and video files, as well as those files

that cannot be used directly on your site but can be downloaded. The views can be found beneath

the main ‘My Files’ folder and files types visible in these views are:

¢ Images — all JPEG, GIF, PNG and (correctly formatted) SWF files — used in image features,
widgets and directly onto pages

e Audio — MP3 files only — used in SiteMaker jukeboxes

e Video — FLV (Flash Video) only — used in the SiteMaker Video Player widget

e Download Files — All other files types, including DOC, XLS, PDF, BMP, AAC, WMA, MPEG,
WMV, AVI etc — which can be accessed or downloaded using a button link (more on this later)

Organising Your Files
You can also organise your uploaded files through the File Manager. You can create your own
folders (Screen 15, A), rename folders, move files between the folders and delete them as well.
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The File Manager will also enable you to change the file names, delete files (multiple or single) and
sort the files within a folder for easier location.
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Creating links

Basic Linking

You can add a link to almost anything on your page e.g. create a link within text, make an image a
link (Screen 16, A) or add a button link to the page. (Remember that links in text are only
possible with Standard fonts and are not supported in Graphic fonts).
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There are several types of link you can create. A link to a website address, an email link, a link to a
file (for download e.g. PDF, document, mpeg etc), a link to another page in your site, a PayPal link
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(to sell things) and a login link (provides a link to the pop-up login panel). All of these are available
from the Link tab on the page Editor (Screen 16, B) and can be used at different times for
different purposes.

Turning Text Into a Link
Making your text linkable is as simple as click and drag. Once your text box is in Edit mode (double
click on the text box) you can highlight any word or sentence (Screen 17, A), then go to the

Editor and select the Link tab. You then need to chose what type of link you want, fill in the
appropriate details and click 'Apply' to make the link active.

For example, to create a link to a web page on another site you need to highlight the text, click on
the web link icon (Screen 17, B), then simply add the URL or web site address to the empty field
before clicking the Apply button to set the link. * Don’t forget, it's only possible to link text when
using standard (system) fonts.
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Image and Button Links

The same process is used when applying links to images or to button links. Once the image or
button link has been selected you can use the Link tab on the Editor to choose the type of link you
wish to apply and then choose your web address, email address, file, internal page etc. Always
remember to click 'Apply' to set the link.

Testing Your Links
Links will not be active while you are in edit mode, e.g. they will not respond when you click on
them. So the best way to test your links is to use the ‘View my site’ option (Screen 17, C), taking

you into 'View mode'. This displays how visitors would view your site and allows all links,
navigation and features to work correctly.

14



Beginner's Guide

Adding and Organising Pages

You can add new pages, change the name of existing pages, or change the order in which your

pages are listed in your menu, by using the 'Organise pages' function.

This can be found on the 'SiteMaker toolbar' by clicking on the 'Pages’ button, then the 'Organise
pages' option (Screen 18, A). Once you have selected 'Organise pages', the 'Pages' panel will

appear. This shows each of your pages in the order they appear in the menu.
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Changing the name of your page in the menu
The name of your page as it appears in the menu, is displayed on the 'Pages' panel in a text box,
e.g. 'Welcome'. You can click in this text box, delete the current text and insert a new page name

(Screen 18, B). Remember to keep your page names short and relevant, as a long description
won't always fit in the menu.

Changing the order of your pages

Your pages are shown in a numbered list indicating the order they are displayed in the menu.
There is a 'drag’ area in the centre of each page item, which you can use to change the order of
the pages (Screen 18, C). Simply click on the 'drag' area and drag the page up or down to the
position you want it. The order of the other pages will then be adjusted so that they are
renumbered correctly.

Making a page a sub-page

You can make one of your pages a sub-page of another page, meaning it is not displayed in the
main menu initially, but will appear as another option (or sub-menu) when you roll over the 'parent'
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page or menu item. Next to the page number on the left is an arrow, one for each page, labelled
'Create subpage' (Screen 18, D). Simply click on the arrow to make your page a 'sub-page’ of the
parent page above or click again to revert it back to a parent page. This will be shown by indenting
the page relative to its 'parent’ which may be several sub-pages above.

Adding a new page
You can add a new page to your site by clicking on the 'Add a new page' button in the top right
hand corner of the page. (Screen 19, A)
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You will then be asked to select the type of page you want to add, e.g. '‘Blank page’, which will be a
template for your new page. Pick the one that's closest to your purpose, but don't worry, you can
add anything you like to your page later. Next you will be asked to give the page a name (which
will appear in the menu), set the visibility (you can hide pages for privacy or while you work on
them). Clicking ‘Next’ will now give you option to place your page before or after specific menu
pages or insert it at the end of your menu. ‘Finish’ will complete the process.

Click 'Apply' when you have finished adding pages or making all your changes and your site will

reload with the new menu in place. None of your changes will take effect until you have clicked
'Apply' and exited the 'Add and organise pages' panel.
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Editing hidden pages

When you've added a new page you may want to keep it hidden until you have completed the
contents. To do this you can use the 'Organise Pages' panel to set the page visibility. Next to every
page name in the list is the 'Page visible' radio button (Screen 20, A) which allows you to remove

pages from your menu, making them invisible to your visitors. When you have finished setting your
visible or invisible options, click 'Apply' to set the changes.

While the page is 'invisible' you can still edit it by using the 'Pages' drop-down list (Screen 20, B)
in the SiteMaker Toolbar to navigate to the page and then edit it as normal.

SiteMaker 4.0 [Affichage normal] e

Sauvegarder E)Fichiers A+ Chare™ %;, Pages ™ - o Ingert ™ 'J Design + QJ Design ™ T Supprimer 7 Aide | Voir mon site:

Organizer les pages  Chrleiaj+0

Bienvenue, kevinicus |

Bienvenue

Ma Collection

i-j-' Ajouter une nouvelle page ) -I

Comment sinscrire

Afficher

Contactez-moi
e |

B
®
®

Comment s'inscrire
L L
Contactez-moi

12 collection )

Bienvenue

Larem ipsum dolor it g
diam nanumrmy nibh e
magna aliguam erat volutpat. Lt wisi enim ad minim veniam,
quis nostrud exerci tation ullamcarper suscipit lohoris nisl ut

Screen 20

17



Beginner's Guide

Image tools

Image tools are a great way to customise, organise or display your images. SiteMaker offers a
range of features and widgets that allow you to be creative.

Pop-up Gallery
The Pop-up Gallery (Screen 21, A) is a very useful widget for showcasing images or products

and it's easy to add. From the File Manager locate the ‘Image tools’ folder and then double-click
‘Pop-up Gallery’ or select the file and click ‘Use this’.
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Screen 21

Using the Setup tab on the Editor (Screen 21, B) you can change the number of columns and
rows on the gallery, whether images are cropped and if they should keep their aspect ratio (the
ration of height to width remains the same). Advanced options let you apply padding, spacing, pop-
up size and a very useful feature that stops your images from being downloaded by visitors. The
Style tab allows you to apply some colour to the widget.

Adding your images is achieved by using the Add Image option on the floating toolbar within the
Pop-up Gallery (Screen 21, C). You also have tools to open up an image to have a closer look,
change the order of your images, as well as a delete image function.

Slide Show

This can add a touch of professionalism to your site if you rely on visual impact (Screen 22, A).
To create a slide show for your images open the File Manager and locate the ‘Image tools’ folder.
Double-click Slideshow or select the file and click ‘Use this’.
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Screen 22

Through the Image tab (Screen 22, B) you can use 'Add images' to browse and select your
uploaded image files. 'Organise’ will permit you to change the order of the images in the slide show
and update the caption for each image. 'Advanced' gives you a few more options including the
slide timing.

'Setup' provides choices on the number of thumbnails to display, cropping, placement of controls
(play, pause, skip) and for a nice touch, the chance to add music to your slide show.
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Crop Tools
You can highlight individual images with a choice of frames using crop tools e.g. a Polaroid crop
tool (Screen 23, A). To add one of many great crop tool styles to your page, open the File

Manager and locate the ‘Crop tools’ folder. Browse the folder and double-click your choice or
select the file and click ‘Use this’.
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The Setup tab will let you browse (Choose an image) through your uploaded images for an
appropriate image (Screen 23, B). Once added the Reposition button will allow you to move the

image position within the Crop Tool. You can also adjust the transparency of the image and there
are several border styles to choose from.

The Link tab will allow you to set a link on this widget. Details on how to apply links is provided
elsewhere in this guide.
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Video

This gives your site more interactivity by allowing you to play videos on your site (Screen 24, A).
You can use videos which are hosted on external publishers i.e. YouTube, Google Video, Kewego
and MySpace or you can add your own video.
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If you want to add your own video directly to SiteMaker you will first need to convert it to FLV
(Flash Video) format. FLV is the same format used by the likes of YouTube and Google Video.
Converters are easily found on the internet and many are free. You can also upload your video to
YouTube or Google Video and then link to it from the SiteMaker video player.

To add Video to your page start by adding the video player widget (in the Video folder), then select
the Setup tab (Screen 24, B) and decide if you are using your own uploaded FLV video file or
using a video feed from an external source. If you are using your own FLV then just browse your
uploaded video files, highlight one, click ‘Use this’ and then use ‘Apply’ on the Editor.

NB. If your video does not appear in the Video views but it can be found in the Download Files
views, then it has not been successfully converted to FLV.

To set up a video feed from an external source use the ‘Choose a provider’ dropdown on the video
widget (Screen 24, C), select a provider and use the ‘Go to’ button. The video provider will open
in another window where you can then locate your video. Copy the video code or video
URL/address supplied by the provider or just copy the web address from the browser address bar
and paste this into the blank field on the Setup tab.

To complete the task visit the Style tab and choose the colours for the controls, background and

border, and then decide whether your video will play automatically when a visitor lands on your
page and whether the main controls will be displayed in the player.
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Creating an Order Form or Feedback Form

Forms can be used to capture customer data on your website. You can create contact forms, order
forms, feedback or membership forms using our highly customisable advanced form widget. We
provide you with a flexible tool that allows you to set up different 'fields' to capture different types of
information. You can use radio buttons, check boxes, drop-down lists and text boxes so that you
have a wide range of ways to organise and capture your information. There is also an option to
permit visitors to upload files with the form, with the option giving you control over the size of the
files that can be added. Some of the fields can also be set up to validate the data that is entered
into them, e.g. make sure an email address has a @ sign in it.

Adding a form to your page can be done using Insert on the toolbar and selecting Form from the
drop down, or you can find it under Forms in the File Manger.

Double-click the form to customise the form title and labels for each field. Simply click on the field
title to edit it (Screen 25, A). When a field is selected it is highlighted in yellow. In this mode you
can also move it up or down the list by clicking the arrows on the bottom right corner of the field.
You may also delete it using the 'x'".
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When a field is selected the Field tab on the Editor allows you to change the settings of that field
(Screen 25, B). This may include the label position, the width and height of the field itself, or
whether it is a 'required' field, e.g. must be completed by the visitor before the form can be
submitted.

You can also use the Field tab on the Editor to add new items to your form (Screen 25, C). This
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may be an input field, text area, radio button group, drop-down list, list box, check box or file
upload feature. Each can be used to collect different types of data.

The Setup tab on the Editor is used to customise how you want the form data delivered to you.
You can set up an email address so that every submitted form entry is emailed direct to you. Or
you can use the 'Download data' button to download a complete list of all form submissions that
you have had (since creating the form or since resetting the data), so that you have a complete
record of all entries. The Setup tab also allows you to customise the 'Success' or 'Error' screens a
user would see once they have submitted or incorrectly submitted a form entry.

Interacting with Your Visitors

SiteMaker includes a number of features that allow you to create interactive sections of your
website. These include the Comments widget, the Chat widget and the Forum.

Comments Widget

The Comments widget is a tool that site builders can add to any page, which allows visitors to their
site to post comments which are visible to everyone (Screen 26, A). You can have several
Comments widgets on the same page, and give each of them a title relevant to what they're about,
e.g. 'What do you think about this video?' The Comments widget allows you to moderate
comments before they are shown, or delete inappropriate comments, so site owners have
complete control. The comment widget also publishes comments to an RSS feed (Screen 26, B)
which means that visitors can subscribe (not paid) to the feed and receive updates when new
comments are added. The impact of all of this is that site builders can have far more user
generated content and interaction on their sites, which will keep visitors returning.
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To add a Comments widget, open up the File Manager and go to the Functional folder within the
Library. Select the Comments widget and then click 'Use this'. The 'Setup' tab (Screen 26, C)
allows you to choose if comments are immediately visible or require you to moderate them first.
The Style tab allows you to customise the look and feel of the Comments widget, including use of
Themes that is available in several other widgets i.e. Chat and Forum. The ‘Show filter’ option
gives you further controls to show just the headings or include comment body, approve individual
comments and reject or delete them (Screen 26, D).

Chat widget

The Chat widget allows you to host live chats with any members of your site who are on the site at
the same time (Screen 27, A).

To add the Chat widget to your page, open the File Manager and go to the Functional folder of the
Library. Then select the Chat widget and click 'Use this'.
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Your chat is then added to your page and ready to go. Like Comments and the Forum you can
also customise the look and feel of your widget using the features on the Style tab (Screen 27,
B).

NB. For security reasons only registered users (members) can chat in the chat rooms. Make sure
you include a Join button on your site if you want to use the Chat tool as this will enable visitors to
become members.
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Forum

The Forum feature (sometimes called the Message Board) allows you to have multi-subject
discussions on your site. It's a great tool for setting up help guides, getting feedback, or to create a
general information resource for your website.
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The SiteMaker forum allows you to have subjects/topics/posts/views for many different threads of
discussion, to set permissions, e.g. guests or members only, to create moderators to help you
manage the content, and much, much more.

To add the Forum to your page open the File Manager and go to the Functional folder of the
Library. Then choose Forum and click 'Use this'.

To add a new subject, which is the top level of discussion or headlines, click the New Subject
button on the Forum (Screen 28, A). You can then give it a title and set up permissions e.g.
guest or member rights. As Site Leader, you are the only one permitted to create, edit or delete
(Screen 28, B) subjects. When your subject is set up, you can then click on it (Screen 28, C) to
enter that part of the forum, and start a new topic using the New Topic button. Visitors will now be
able to create new topics in your subject, or reply to existing topics using the New Reply button
(Screen 29, A).
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Returning to the topic, the subject or right back to Forum index is as simple as clicking on one of
the links in the ‘breadcrumb trail’ provided (Screen 29, B). As with the Comment widget the

Forum also permits the content to be published to an RSS feed (Screen 29, C) so that visitors

can subscribe for free to the feed and receive updates when new posts are added.

Global Design Settings

You can change your fonts, menu style, background and more with the Global Design settings.
The Design section of the SiteMaker Toolbar allows you to change the default design settings of

your site (Screen 30, A). Within the Design section you can change default font choices, your

sites menu, your background and loading bar.
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Fonts

The Body font and Title font sections of Design allow you to change the default fonts used within
your site. This means any fonts already on your pages and any new fonts added will change to
your new font choice. This is an easy way of changing the look and feel of your site rapidly. In the
font section you can choose a new default font and colour (Screen 31, A) which will be used
throughout your site. (NB. If you have changed some text on a specific page away from the
original default font, it will keep your custom setting, e.g. it will not revert to the new global default).

If you want a wider choice of fonts you can also swap between standard (system) or graphic fonts
giving you more creative choice (Screen 31, B).

SiteMaker 4.0 [Affichage normal]

Bienvenue, kevinicus |

Sauvegarder E) Fichiers 4 Charger ) Edition = ?;, Pages ¥ - Insérer ¥ 'J Desion ¥ T Supprimer 7 Aide ¥ | Voir mon site

Configuration graphique globa
[ Poicedetaxte | Policedetite | Ariéreplan || Menu i

Bienvenue

E Police de titres : Univers Gondensedbold

Polices graphiques Q’
|Univers Cte dhoid I ] E

L Predapoices | Police de titre :

Larem ipsurm daolor sit amet, consectetu
incididunt ut labore et dolore magna alig
nostrud exercitation ullamco labaris nisi
Duis aute irure dolarin reprehenderit in
nulla pariatur. Excepteur sint occaecat cy
officia deserunt mallit anim id est labory

ikducion | Aoz | Wes i

1a collection )

Bienvenue

Lorer ipsurn daolor sit
diam nonumimy nibh evismod tineidunt ut lagreet dolare
magna aliquam erat valutpat. Utwisi enim ad minim veniam, o B T

J Annuler || Appliquer

Screen 31

27



Beginner's Guide

Background

The Background object on your site sits behind all of your page content. Normally this is a plain
colour, but can have patterns and multiple colours for different areas. In the Background section
you can change either the colour of your existing background (Screen 32, A), or select a new
Background from the File Manager (Screen 32, B).
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Menu

Using the Design section of the SiteMaker toolbar you can also change the design style, colours,
position and scale of your menu. Simply click on Design - Menu to open the menu section. The
'Global design settings' panel will load and the ‘Menu’ tab will be displayed. You will see the design
options for your menu on the left (Screen 33, A), and a preview of how it will look on the right.
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The colour of your menu items, their rollover colour and the colour of the text can all be modified.
The 'colour chip' icons (Screen 33, B) display your current colours and allow you to click on them
to choose from an alternative palette.

For an entirely new menu style, click on the '"New menu style' button (Screen 33, C). This will
open the File Manager and allow you to browse the different types of menus available, including
horizontal menus.

Page Master

The ‘Page Master' is a layer that sits behind every page on your site. Any object that is placed on
your Page Master will appear in the same place on every page in your site. This is where your
menu and logo (your website name) live, which is why they appear in the same place on every
page of your site. The Page Master can be very useful for putting information that you want to
appear on every page, e.g. copyright information or a contact link.
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To get to the Page Master go to the Design menu in the SiteMaker Toolbar and select ‘Page
Master' (Screen 34, A). This will then open the Page Master and show you only this unique
background layer. You can edit the Page Master just like any other page and add or remove
content as required. But remember, anything you add to this page will appear in the same place on
every page, so be careful not to clutter your site!
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Moving the Menu

Once in Page Master mode simply click on your menu to select it (Screen 35, A). Once selected
the 'drag and scale' handles will appear. Now drag your menu to a different position on the page.
Or use the 'drag and scale' handles to make it bigger or smaller by dragging one of the black
squares in the corners in or out. NB. Remember that your menu will appear in the same place on
every page of your site, so make sure you put it somewhere that won't interfere with your other
content. When you have finished positioning and scaling your menu, click 'Save' on the ‘Page
master’ panel (Screen 35, B), and then 'Exit' to go back to editing the other pages in your site as
normal.
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Your Website Logo

Your logo or site name will usually be on the Page Master too. In Page Master mode you can edit
the site logo by double-clicking it (Screen 35, C) and changing the text as you would with any

other text box. Just save and exit the Page Master, as you did with the menu to keep your
changes.
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Hiding Your Menu or Website Logo

It is also possible to hide the Page Master on a specific page (or pages). To do this, go to the page
on which you want the Page Master hidden, go to the Toolbar, click Edit > Page Settings
(Screen 36, A). This loads the Page Settings panel with the Settings tab offering a number of
options. Choose 'Hide the Page Master on this page' (Screen 36, B) to hide the contents of the

Page Master, including the menu and website logo, from this page alone. For example, this
automatically happens when you add an Intro page (through the Pages menu) to your site.
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SiteMaker 4.0 [basic view]
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Site Settings

Your SiteMaker site is initially set up with a fixed width and height, meaning you cannot drag or
add content outside the site border. However you can change the size and height of your entire
site, or on a page by page basis. To change the default height or width of your site go to Design ->
Site Settings and click on the Size and Margins tab. On this panel you will find Site Size (Screen
37, A), a drop down box which allows you to change the default size and shape of your site. All
measurements are provided in pixels. There are a number of preset options to choose from, or at

the very bottom of the list you can select the 'Custom’ option which allows you to set your own
values.

Also on this panel you can set some of the HTML alignment options, e.g. whether your site is
aligned left, right or centre in the browser window as well as top and bottom (Screen 37, B). The
Site Margins settings allow you to create padding around your site, e.g. if it is aligned to the top

(i.e. at the top of the browser window), you can set a Top margin of 10 (pixels) to create some
padding between the browser and the top of your website.
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Border and Icon

The area in the browser outside your site is referred to as the HTML 'Background'. You can set the
colour of this background or you can upload an image to appear as the background to your site. All
of this is done on the 'Border and Icon' panel in 'Site settings'. Either select a '‘Background colour'

using the colour picker (Screen 38, A), or upload your own file to use as the 'Background image'.

You can also create a coloured border around the edges of your site area by using the 'Border

colour' and 'Border width' settings.

Some users also like to set a 'Favourites icon' (or Favicon) which is used as a small image next to

your site address in the browser address bar. To do this use the 'Choose icon' button in the

'Favourites icon' section (Screen 38, B). NB. You will need to create a 16x16 px (pixel) or 32x32

px “.ico’ file to upload. Tools to do this can be found online or do a search on ‘favicons’.
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Finding your site on the internet

Search Engines

The Holy Grail of all questions! How do | get found and generate business for my site?
Unfortunately there is no simple or easy answer to this. We have another guide (SEO guide) which
deals at length with this issue and how to set up your site for Search Engine Optimisation (SEO).

The summary answer is as follows. It will take several months for your site to be listed in Google's
search results. This is because millions of new sites are added each day to the internet and even
Google takes a while to find them all. Have patience, it will happen.

Just because your site is online doesn't mean people will find it by accident. You need to invest
time and effort in both SEO (see our guide) and in (off-line) promotion of your site through other
more traditional means, e.g. tell people about it, add your address to your offline marketing
materials/business cards, etc. It doesn't have to cost much, but it can take quite a lot of thought,
hard work and time to be successful. Don't expect too much too quickly, after all, the best, highest
ranked sites have been around for a long time.

Google Tools
Google offers a number of useful tools that can help provide additional information about your site,

and enable you to manage the way in which Google indexes your pages. These tools are: Google
Analytics and Google Webmaster Tools.

Google Analytics

Google Analytics is a free service that allows you to track and monitor activity on your site. You
can sign up with Google who will give you a unique ID to put in your site which will track user
activity. From this you can see which are your most popular pages and how frequently people
return, which sites your website was referred from etc. There is a huge amount of information
available.

To set up Google Analytics you will need to open the Admin panel, select the Statistics tab
(Screen 40, A) and then:

1. Click on the Sign up for Google Analytics button (Screen 40, B), which will open a new panel

(Google Analytics) and then use the Get your Google ID button (Screen 41, A).
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2. You will then be taken to Google's own Analytics page where you can sign in to your Google

Account (or register for one).

3. Sign up for Google Analytics (or sign in) - this will ask for your URL (website address), account

name (something appropriate), and your time zone.
4. Then, after providing your name, you'll have to accept Google's terms and conditions.

5. You will then be presented with a code block containing your Google Analytics ID which you

need to copy (to your clipboard).
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6. Almost there! Go back to the Admin panel on your site (it should be still open in another window
or tab) and paste the code block into the spacious ID field (Screen 41, B) on the Analytics panel.

7. Click OK to save and then just be patient while Google begins to collect data about your site and
your visitors.

Depending on how popular your website is your stats may take a few hours to start collecting data
or it may take several days. There is a lot of detail and data, so if you love statistics you'll definitely
be in heaven. The key stats for most users will be:

* Daily visitors (how many visitors and what percentage are new)
* Visits & Page View Tracking (the number of visits which is distinct from your visitors)
* Content Drilldown (the popularity of each page on your site)

Google's Help is pretty extensive so spend some time understanding the stats and you'll have the
basis for some very useful information. They provide good graphing for the visually inclined, plus
they offer good options for printing and saving to various formats on your computer.

Google Webmaster Tools

Google Webmaster Tools are provided by Google for free and allow you to set the frequency with
which it indexes your site, and also submit a Sitemap to make sure it indexes all the pages you
want it to.
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First you have to verify your site with Google. To do this, go to Admin from the SiteMaker Toolbar
and click on the Site Information tab (Screen 42, A). Then click the 'Sign up for Google
Webmaster Tools' button (Screen 42, B).

36



Beginner's Guide

On the bottom of the Webmaster Tools panel click 'Get your Google ID' (Screen 43, A). Google
should open in a new window and ask you to sign in. You'll then be taken to the Google
‘Dashboard’. Add your website address in the blank field and click ‘Add Site’, then look for the
‘Next step’ box and select ‘Verify Site’.
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Go to the ‘Verification Method’ drop down and select ‘Add a meta tag’, copy the code string, e.g.:
<meta name="verify-v1" content="UqbdIVXyU8m8PIVvMSJLj+W6bf5Sa4An1CZcxazTgafs=" />,
and then return to your SiteMaker website which should still be open in another window. Paste the
code string into the blank field in the “‘Webmaster Tools’ panel (Screen 43, B) and click ‘OK’,
followed by ‘OK’ on the Admin panel. Your site will now have the Google Verification code added
to the HTML and can be verified by Google. The verification may take 24 hours to complete.

Once this is done you can use Google Webmaster Tools, including the ability to submit a SiteMap.

Sitemap

We automatically generate a Sitemap XML file which search engines will index whenever they visit
your site. We automatically publish all pages which are visible in the menu and withhold those that
are hidden. If you wish hidden pages to be published you will need to visit the hidden page, click
on Edit and then go to Page Settings. You can then select the check box for ‘Include this page in
my Site Map’.

To view your site map, you only need to add "/sitemap.xml" to the end of your website address (or
URL) in the web browser address bar e.g. www.mysitename.com/sitemap.xml

To add your Sitemap to Google Webmaster Tools, login into your Google account, locate your site

and click the 'Submit a sitemap' button. Once this is done successfully, Google will have an up-to-
date list of all the pages in your site.
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